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Introduction
The philosophy behind 2Do
There are a variety of methodologies when it comes to 'getting things done'. Each method 
comes with its own baggage of simple to semi-complex rules that must be adhered to. The 
terminology used alone can at times be intimidating to some. If only we could simplify the 
terminology and have the versatility of mixing these methods at will, we would have the 
ultimate productivity tool enabling us to get things done our way. Enter 2Do. 

2Do can be as simple or advanced as you want it to be, starting with the user interface to the 
various features it hosts. With simple tasks to complex recurring projects and filters, 2Do 
gives you the flexibility you need in managing the different facets of life - just the way it 
should be.
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Introducing the user interface
The following will give you a general overview of some of the main characteristics of the app:

1. Toolbar

The toolbar consists of shortcuts to the functions you'll be using the most:

1. Create a new task by clicking the [+] button or select from a variety of options, such as 
creating a new project or a sub-task, by clicking the drop-down button.
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2. The Global Search Bar. This is an all-in-one auto-collapsing search bar that expands 
when needed and tucks away when there's nothing more to find. You also create and 
manage smart lists from this very search bar.

3. Toggle to show / hide the Utility Panel

2. Lists Panel

A list, by definition, holds a collection of tasks. This panel is 
where the built-in lists are displayed alongside those you 
create and manage yourself. There are three kinds of lists in 
2Do:

!Focus: These are built-in lists that act as special filters 
when selected. The 'All' list displays all tasks whereas 
'Today', 'Starred', 'Scheduled' and 'Done' only display the 
tasks expressed by their names. 

!Lists: This can hold a collection of Tasks, Projects or 
Checklists and can be colored to any color of your 
preference. You can double click on the group name to 
rename them. In the example above, we have created the 
following list groups: Personal, Work, Self-improvement, 
Sports and Traveling

!Smart Lists: These are, in simpler words, saved searches. 
Smart lists filter on the list they were create in (such as 
Home) and can be used in order to apply dynamic date 

ranges, fixed dates, tags, keywords etc.
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3. Tasks List

�

This portion of the app is where you will create and manage your tasks. Tasks can be sorted 
in the manner you like, using one of the various sort options available by clicking on the 
drop-down button visible above the list. More on sort order has been described in the 
Managing Tasks section.

�4



4. Utility Panel

�      �

This panel is where you would access all the tags and locations you create in 2Do. Tags and 
locations can be assigned to tasks while they’re being edited or created, or can be created 
and managed directly from here. 

The Tags and Location panels also provide you with the ability to search for tasks that use a 
particular tag or location.

The visibility toggle button at the bottom right allows you to switch between two modes: All 
Tags or Use Tags. This is useful if you wish to quickly filter out the tags that aren't in use by 
the currently selected list, and concentrate on the ones that are.
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5. Calendar

�

The calendar shows you the current month and date, and has an indicator on the upper-right 
corner of date cells that are busy (i.e. a task starts or is due on this date). Tasks can be 
dragged and dropped on a date to change their due date, and the date cells can be selected 
in order to perform a date range search on the currently selected list.

About the built-in Focus Lists
The built-in focus lists are special filters that give you quick access to all or a sub-section of 
your tasks.

All
As the name suggests, the All list will show you all of your tasks in single place. If you have 
lots of tasks in multiple lists, All will give you a good overview of what's coming next, and 
from which specific list. You can then sort the list the way you like, or use additional filters, 
such as a Focus Filter, to drill down to the tasks you're immediately interested in.

Today

Although the All list, combined with Due Date sorting, will show you what's due today, this 
isn't always ideal. You could easily have hundreds of tasks displayed under All or have sub-
tasks (as you will learn more about these soon) that are due today but not immediately 

�6



visible because they're shown collapsed under their respective projects to begin with. 
Furthermore, depending on your workflow, you could have set up the All list with specific 
Focus filters, in which case tasks that are due today could have been filtered out.

The Today list will show you what's due today, or optionally include what's now overdue, in a 
single place, irrespective of where these tasks reside. 

Tip: You can drag and drop tasks from the main list on top of the Today list to set their Due 
Date to Today.

Starred
2Do allows you to set a priority to a task, and also to flag it with a star. A star can mean 
different things to different people. To some it means "I'm working on this now" while to 
others it could mean "Must do this next". Whatever your workflow, the Starred list gives you 
immediate access to all tasks, sub-tasks, projects etc that you have starred in different lists 
under different projects.

Tip: You can drag and drop tasks from the main list on top of the Starred list to star them.

Scheduled
Some people think in terms of Start Dates for their tasks instead Due Dates, or even both at 
the same time. The Scheduled list filters out and displays all tasks from the various lists that 
have a start date set to some time in the future. This allows you to plan ahead, or to simply 
get a good overview of what you need to be thinking about next.

Done
All tasks that are completed appear under the Done list sorted by their completion date. 
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Learn the Keyboard Shortcuts
For manipulating a task (such as setting quick priorities, deferring dates and so on), please 
look under the ‘Task’ menu after launching 2Do. We would also recommend that you 
download a free app called ‘CheatSheet’ (http://www.cheatsheetapp.com/CheatSheet/) 
which immediately displays all available shortcuts for an app using a single keystroke.
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Getting Started
Learn about Lists, Tasks, Projects and Checklists

List

A list is a collection of simple tasks, projects and checklists. Lists can be sorted 
independently, filtered, password protected and colored.

List Group

A list group is a collection of lists. You can create multiple list groups and use them to 
organize and rearrange your lists.

Task

A task represents a to-do item and can have its own title, a note, priority, start and due dates, 
an embedded audio note, an embedded picture, and multiple alarms. A task can also be set 
to repeat periodically upon completion based on due date or completion date.

Project

A project has all the properties of a simple task. Additionally, a project can contain other 
simple tasks as sub-tasks.

Checklist

A checklist is a lot like a project, with a single exception: sub-tasks cannot be assigned their 
own due / start dates, and instead, borrow the dates from their parent checklist.
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Manage Lists
Creating a new List
You can create a list for the various tasks, projects or checklists you wish to manage. The 
following are the various ways you can create lists.

Using the bottom bar

�

Click on the + button to create a new list

Using the Menu

�

Renaming the list

�

Rename the list once its created.
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Renaming a list
There are various ways to rename a list:

Renaming by double-clicking the list title

�

Renaming by right-clicking on any list title

�

Renaming by clicking on the list settings button

�
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Changing a List's Color
You can assign a list any color you like. These colors are used for identifying the list the task 
belongs to.

Right-click the List

�

From the context menu, select a pre-defined color from the available list or click on 'Custom' 
to show a custom picker

�12



Pick a custom color

�

Using a custom color will allow you to pick any color or shade you like.

The selected color appears beneath the list name

�

The Color Band

�
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The new color will now reflect next to the list name, as well as on top of the color band next 
to a task's checkbox. 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Learn about Overdue and Undone counts
Changing Preferences
Using general preferences (Menu > File > Preferences), you can optionally switch the 
visibility of counts ON or OFF on top of lists. 

Identifying the counts

�

There are two different counters displayed next to a list name:

1. Undone: This counter appears to the right, displaying the total number of dated or 
undated simple tasks, projects or checklists which have yet not been completed. This count 
does not include the total number of uncompleted sub-tasks, if there are any. Sub-task 
undone counters appear on top of the Project indicator (see Creating a Project).

2. Overdue: The overdue counter displays a count of the total number of simple tasks, 
projects or checklists that are now overdue (i.e. they have a due date set which is now in the 
past). The overdue counter will always appear in addition to the Undone counter, and is 
placed on the left with a clearly marked red font.
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Learn how to Sort and Focus
The Sort Bar

�

The Sort Bar is where you look for 'sorting' and 'focus' options. This is also where extra 
information is shown at times that directly relates to the tasks being displayed.

1. The Sort drop-down (the one that reads Due Date) button has two parts to it. The little 
down arrow button to the left toggles Ascending and Descending sort. The rest of the 
button when clicked will show a drop-down menu with the sort options.

2. The Focus button also has two parts to it. Click on the sun icon to toggle Focus mode 
(described below). The down arrow to the right will display a menu with several focus 
options.

Changing Sort Method

�

! Click on the sort button where it says 'Due Date' (default sorting method)

! Click on the sort method you would like to use instead.

Please note that the sorting method you select for one list will be associated with that 
particular list only. You cannot have a global sort method that applies to all lists. This is an 
extremely powerful feature given you can sort different lists based on different sorting 
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methods. For example, you could have a List dedicated for 'Shopping' and set it to sort on 
'Status' (i.e. Done and Not Done). That would make more sense, as you don't necessarily 
care about due dates when managing a shopping list.

Separated

This option is checked by default. Uncheck this to display your tasks under a single list 
partition instead. This can be useful for a 'Someday' list where you don't necessarily have 
fixed due dates assigned to tasks, and don't care when a task is due. Instead, you'd like to 
look down at a single list without interruptions.

Using the Focus Filter

�

By default, Focus is always off. Focus, as the name suggests, allows you to quickly filter out 
the stuff you don't want, and show only the sub-set of tasks that you'd like to focus on. You 
could have hundreds of tasks in a particular list with due dates allocated throughout the year, 
for example, but with a click of a button, you toggle Focus to show you only the things that 
are important right now.

The screenshot below, for example, has three options selected: Today, Tomorrow or 
Starred. The focus filter, when toggled ON, will then only show the tasks that match one of 
these options, and hide the rest.
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�

The sort bar will also show you a count of the number of tasks that were hidden after 
applying the focus filter.

Preventing tasks of a certain list from appearing in the 
built-in 'All' or ‘Today’ list
Consider your daily busy life at work or at home. Many times there are unimportant tasks 
that you create but don't want to be nagged about when looking at an overview of all your 
upcoming or overdue tasks. Yet you want the best of both worlds; be able to focus in on 
them when you've got the time and ignore them automatically when you don't.

A very easy way to accomplish this in 2Do is to first create a dedicated list for such tasks, 
and then simply right click on the list and select 'Exclude from All' like so:

Right-click the list name

�

Click on 'Exclude from All' in the context menu.
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List icon displays an eye icon

�

This will result in changing the icon to reflect your intention of hiding tasks belonging to this 
list when viewing the 'All' list.

You can exclude a list from appearing inside the ‘Today’ list by clicking on ‘Exclude from 
Today’ from the context menu.

Password protecting your lists
In 2Do, you can choose to lock individual lists or the whole app with a password. The 
following steps will show you how to do this:
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Open Preferences > Security

�
! From the menu 2Do > Preferences... click on Security

! Click on Set Password and follow the prompts to set a new password

! Once the password has been set, click on the checkbox next to the list names you wish 
to lock

�20



Click the lock icon to Unlock

�

A lock icon will appear next to the list which has been locked. To unlock, click on the lock 
icon.

Locking your list manually

�

Once unlocked, a list manually can be locked manually at any time by clicking on the 
padlock button next to the list name in the title bar.

Locking all your lists

�

If you wish to lock everything instead of locking individual lists, click on the Lock everything 
checkbox. The app will then greet you with the following view once locked:
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Locking Everything

�

Hiding unwanted Lists
2Do lets you hide unwanted lists so these don’t appear in the listing on the side bar. You 
might want to do this if, say, you don’t want to see one of the built-in Focus lists all the time 
(such as Scheduled), or if you specifically want to hide a list from prying eyes. 

To hide a list, follow these instructions:

! From the menu 2Do > Preferences... click on Security and then Privacy

! Click on Click the lock to make changes to authenticate yourself

! Check the lists you don’t want to see on the side bar

If you’re syncing using the Dropbox option, this setting will sync across other devices as well.

Inbox
With 2Do 2.0 we added an option to turn on a native Inbox instead of a default list. Inbox is a 
great way to collect all your tasks and thoughts for processing them later. This way you can 
quickly add your tasks without having to think about details such as due date.
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! To enable native Inbox, open Preferences > General and turn GTD Inbox switch on. If 
you previously had an Inbox list set, GTD Inbox will take over it and include all tasks from 
the list. 

! If you want all tasks created in 2Do to end up in the Inbox by default no matter what list 
you created them in, you can turn on Always Use Default List option. Your tasks will still 
inherit Today’s due date or Starred state of you created them in respective focus lists 
though.

Inbox list belongs to preset Collect list group which can’t be manipulated. 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Managing Tasks
Overview of the Task Edit Mode

�

This view is presented to you every time you create a new task or edit an existing task. The 
same view is also presented by the Quick Entry window

1. Title

2. Priority and Starred status

3. List selection drop-down

4. Tags

5. Notes

6. Attach Picture

7. Attach Voice Note

8. Locations

9. Task Actions

10.Recurrence (select from various repeat options and optionally specify an end date)

11.Alarms (add multiple alarms based on relative time or exact date and time)

12.Duration
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13.Start and Due Dates

Creating a new Task
There are various ways you can create a new task:

Create using the Toolbar

�

Creating using the Menu

�

Alternatively, use the CMD-N keyboard shortcut to create a new task or double-click on an 
empty area of the Task List.
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Creating using Quick Entry

�

Learn more about Quick Entry

Creating from text in pasteboard
At times what you really want, is to be able to create multiple tasks from multiple lines copied 
from another application. For example, you could multiple new tasks based on a list of bullet 
points from an email, a document and so on. 

Simply press CMD+C to copy text from another application and hit CMD+V after launching 
2Do. If you wish to create sub-tasks from text present on your pasteboard, highlight a project 
or a checklist and hit CMD+V.  

Creating a Project
A project allows you to create further sub-tasks which are related to the main project Each 
sub-task can have its own due date, start date, alerts and so on.

There are various ways you can create a new project:
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Creating using the Toolbar

�

1. Click on the drop-down menu button next to the Add Task button

2. Click on 'New Project' 

Creating using the Menu

�

Alternatively, use the CMD-ALT-N keyboard shortcut to create a new project.

Creating from existing tasks
Learn how to create a project from an existing set of tasks.

Identifying Projects

�
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Projects appear with a distinct briefcase icon instead of a traditional-looking checkbox. This 
briefcase icon can be clicked in the same way you would click a checkbox, but will result in 
marking all sub-tasks as completed too. If you click on the briefcase icon for a project that 
has unfinished tasks, you’ll be asked to confirm that you wish those items, along with the 
project, to be marked as complete.

The number inside the icon indicates the total number of uncompleted sub-tasks. If you 
would like to see a percentage of completion instead, press the spacebar key on your 
keyboard to invoke Quick Look.

Creating a Checklist
A checklist allows you to create further sub-tasks which are related to the main checklist. 
Checklists are different from Project in that its sub-tasks cannot have their own Due Dates / 
Start Dates and instead borrow their parent's start and due date. Furthermore, checklists 
and its subtasks are also treated differently by Smart Lists where individual sub-tasks will not 
appear when searching on a date range.

There are various ways you can create a new checklist:

Creating using the Toolbar

�

1. Click on the drop-down menu button next to the Add Task button

2. Click on 'New Checklist' 
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Creating using the Menu

�

Alternatively use the CMD-CTRL-N keyboard shortcut to create a new project.

Creating from existing tasks
Learn how to create a checklist from an existing set of tasks.

Identifying Checklists

�

Checklists appear with a distinct checklist icon instead of a traditional looking checkbox. This 
checklist icon can be clicked in the same way you would click a checkbox but will result in 
marking all sub-tasks as completed too. If you click on the icon for a checklist that has 
unfinished tasks, you’ll be asked to confirm that you wish those items, along with the 
checklist, to be marked as complete.

The number inside the icon indicates the total number of uncompleted sub-tasks. If you 
would like to see a percentage of completion instead, press the spacebar key on your 
keyboard to invoke Quick Look. 
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Moving a task to a different list
Tasks can be moved between lists by a simple drag and drop action. Simply drag the task(s) 
you wish to move, and drop them on the list you wish to move them to. 

Note: You cannot drag and drop tasks on top of Smart Lists. Smart Lists are virtual filtered 
views of an actual lists.

To move a task to a new destination while editing other details of the task, follow the steps 
given below.

Using the List Selector

�

! Double click or hit 'Enter' on the task you wish to edit

! Click on the List Selector drop-down button that appears from the left

! Select the list to move the task to
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Creating a project or a checklist out of other tasks
You can easily create a project out of a selection of existing tasks:

Right-click on selection of tasks

�

From the context menu, click on New > Project from Selection

Give the new project a title

�

Navigating to a project / checklist quickly
What good would the app be if it offered the ability to add projects and checklists, but made 
it difficult to find them from among hundreds of other tasks?
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Although there are preset search filters available which you can use to filter out projects / 
checklists from a given list (read about Smart Lists), there is a much easier way of accessing 
your projects and checklists quickly.

Clicking on the list's disclosure button

�

A disclosure button appears next to the list icon if the list contains one or more projects or 
checklists.

Navigating to the project

�

This will reveal all projects and checklists the list contains. Clicking on a project will highlight 
the selected project in the task list.

Changing the priority of a task quickly
To make it easy for users who prefer using a mouse over a keyboard, we enabled changing 
the priority of a task without having to enter the special edit mode.

Hover mouse over the right side of the task

�
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Setting a new priority

�

Set the new priority and/or toggle the Star flag

Attaching files to tasks
There are many ways to add file-link attachments to a task (note: the actual file is not 
embedded in the task; instead, a hyper link is created for the task, clicking on which will take 
you to the actual file on your Mac).

1. Drag and drop files inside the Notes area when editing or creating a new task

2. Right click on a task and select 'Attach File...'

3. Drag and drop files on top of the 2Do dock icon. This will open the Quick Entry window 
with the link to the file(s) appended to notes.

Sharing tasks with others
The word 'sharing' is used loosely and does not mean 'collaborative task editing'. You can 
share tasks from 2Do with others just as you would share files, pictures, notes etc from other 
apps via email or other sharing mechanisms.

The simplest way to share a selection of task(s) is by using the Edit > Copy menu. This 
copies the details for the task to the clipboard which can then be pasted into virtually any 
app that accepts text.

You can also select multiple tasks and use the Share menu option from under Task > Share 
to Email, AirDrop, Message or more.

�33



Using Quick Entry

�

It's important to be able to quickly capture your thoughts and ideas. When the app is running 
in front of you, that isn’t a problem, but what if the app isn’t running or is hidden away behind 
a dozen other windows and you have to go through a number of clicks and gestures before 
getting to it? That's where Quick Entry plays an important part.

2Do's Quick Entry is quick. Not only can you use a global hotkey to open the Quick Entry 
window, but you can set it to appear centered above the currently focused window. What 
good is that, you ask? Imagine you've got two or even three monitors. You've got your 
browser opened on one, mail on another and you’re on your third monitor working on a 
document. Suddenly, you get an urge to create a reminder. You use the global hotkey and 
voila, the Quick Entry window appears right below your eyes - not on some other monitor or 
some other part of the screen but directly above the document you're working on.

The window hosts a familiar-looking task editing control, and works just like it does in the 
main task list. You can even drag and drop text or files on top of the 2Do dock icon, and it 
will pull up Quick Entry for you, pre-filled and ready to go.

Assigning a Global Hotkey

�
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4. From the menu 2Do > Preferences... click on General

5. Click on 'Click to record shortcut'

One more thing...
Normally, Quick Entry would work only if the app was running or was in the background 
(minimized for example). We decided it would be way cooler if Quick Entry worked even if 
the app was not running, such as after a system reboot or if you were to quit the app 
deliberately for whatever reason. It would be so disappointing to press the hotkey in the 
middle of a thought only to find the app not currently running. 

The global hotkey assignment thus works even if the app was quit deliberately, or is not 
running, or was never launched after a system reboot in the first place. Now that's 
productivity!

Automatic Alerts
2Do can create alerts automatically every time you set a due date for a task. Follow these 
instructions to learn how to do this:

Open Menu > Preferences... > Alerts

You can have two kinds of Automatic Alerts:

Alerts on Due Time

When giving a task its Due Date, you have the option of giving it a Due Time too. If in 
settings you have 'Remind me at Due Time' checked, an alert will be created for you 
automatically at the exact date and time you set for the task. Click on the at drop-down list to 
change the setting to 5 minutes or 10 minutes before, for example.

Alerts on Due Date
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In addition to automatic alerts at due time, you can have alerts created for you at due date. 
This is useful in case you don't ever use due time for your tasks, yet you want to be 
reminded a few hours before a task's due date. 

Note: due dates in 2Do always mean 'Midnight on that day'. Accordingly, a due date of 12th 
October means 12:00am on the 12th of October. If you want to change this behavior, 
checkout the 'default due time' setting under Preferences > Advanced.

Printing
Select menu File > Print

�
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Print Preview

�

You can click on the 'All Tasks' drop-down to instead print only tasks that you have selected 
in the task list.
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Quick Look
Learn to use Quick Look

�

Tasks can have titles, notes, dates as well as other additional properties such as audio 
notes, pictures, file attachments and so on. 2Do only shows a single line of text for task titles 
and notes on the main task list as you don't need to see it all when skimming through the list. 
At times however you want to get a quick look at the task's full title, notes and the rest of the 
properties without the need of entering edit mode each time.

Quick Look was designed to do just that. It gives you a complete preview of all the 
properties you have assigned to your tasks (the full multi-line title, multi-line notes, alarms, 
attachments and so on) with a press of a key. 

Simply press the spacebar to toggle Quick Look for a task. Quick Look in 2Do works 
exactly as it does throughout OS X, when viewing photos, files and documents. While Quick 
Look is showing, you can use the up and down arrow keys to navigate the task list. Doing so 
updates Quick Look to show details of the currently selected task.
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Using Tags
Learn about Tags
Tags can be used as labels that you attach to tasks for easy identification. This is useful 
when you wish to search for all related tasks or create a smart list out of your search.

Managing Tags

Creating Tags

Creating Tag Groups

Assigning Tags

Assigning tags to tasks

Filtering by Tags

Switching between All and Used Tags

Filtering the list by tags
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Creating a Tag
There are various ways of creating a new tag:

Creating a tag using the Tag Panel

�

! Click on the top right Tag button to reveal the dedicated Tag panel.

! Click on [+] at the bottom and select 'New Tag' to create a new tag

! Give the new tag a name

Creating a new tag when editing task
Double click on the task you wish to edit.

Click on the Tags Field

�
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Enter a comma separated list of words

�

Enter comma separated words and 2Do will automatically create new tags for you (where 
one does not already exist for the same tag name).

Creating a Tag Group
A Tag Group is a logical way grouping related tags together. The following is how you would 
create a new Tag Group.

Creating a tag using the Tag Panel
! Click on the top right Tag button to reveal the dedicated Tag panel.

! Click on [+] at the bottom and select 'New Tag Group' to create a new tag group.

Move tags to the new group

�

Drag and drop the tags you wish to move to the new group.
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�

The tags will now appear grouped under the new tag group.

Assigning tags to tasks
! Click on the tag button on the toolbar to show the tag panel

! Click on the tags that you would like to assign

! Drag and drop them on top of the task in the list

Alternatively:

! Select a bunch of tasks you would all like to have the same tag(s)

! Drag and drop the tasks on top of the tag in the tag panel

Switching between All and Used Tags

�

The bottom right button on the toolbar allows you to toggle visibility of currently used tags in 
the selected list. This is useful if you wish to quickly filter out the tags that aren't in use, and 
concentrate on the ones that are.
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Filtering the list by tags
Toggle tag button in Tag Panel to filter

�

The icons next to the tag names in the Tag panel are, in fact, filter toggle buttons. Click on 
one or more buttons to filter on tasks that have these tags assigned.

Alternatively, you can type directly into the search field. 'tags:' (without the single quotes) is 
a reserved keyword which can be prefixed to a comma-separated list of tag names, and 2Do 
will automatically switch to 'tag search' mode. If you would like to perform a logical AND (i.e. 
look for one tag OR another) instead of a logical OR (the default), please read the Advanced 
Searching topic below under the Smart Lists topic
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Searching, Filtering and Smart Lists
Introducing the Global Search Bar

�

The Global Search Bar is a cleverly-designed, but not-so-cleverly-named, search field that 
does a lot more than what's immediately apparent. 

The search feature is probably one of the many reasons why you would switch from a pen 
and paper to using software. At the same time, you don't want the search field staring at you 
all the time since you'll only ever use it to look for something quickly, or to create smart lists. 
For this reason, the Global Search Bar expands on a single click while giving the search field 
immediate focus so you can begin typing immediately, and automatically collapses if it 
detects you're not in the mood to search any more.

�

1. Clicking the magnifying glass button expands the search bar to instead show a [+] button 
in its place. Clicking on this allows you to create Smart Lists based on your searched 
terms and options. You can learn more about Smart Lists here.

2. Typing in the search field will immediately begin to filter the currently-displayed list. Click 
on the little magnifying glass drop-down button to explore the various presets that come 
bundled with the app (see below). 

3. The drop-down button on the right will show date filtering options that you can apply in 
addition to the entered keyword.
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Search Presets

�

There are a number of presets you can use for the several common situations. For example, 
you can filter the list to show only tasks that have a due date set, or tasks that are only due 
tomorrow, or tasks that you have not yet assigned a tag to. Use the Rule Builder to create 
complex combinations of filters and save them as Smart Lists by clicking on the [+] button 
right of the search field.

Date Search Options

�

Date search options can be used in case you're looking for a task that's due in a specific 
date range, or one that has no due date set. You can even use a dynamic date range (such 
as, 'The Next 3 Days') to look for tasks due in the next few days/weeks starting from today. 
This is incredibly useful when creating dynamic smart lists.
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An overview of 2Do's search features
We added an extremely powerful search engine to 2Do while making sure the interface was 
kept intuitively simple to use. In technical terms, 2Do supports Full Text Search (i.e you can 
use wild cards like: hospit*, train OR taxi, etc) as well as Soundex Search. 

So how does Full Text Work?

Full Text uses certain keywords that you can use to refine your search. To use Full Text, you 
will have to ensure Soundex is toggled OFF under search options (as Soundex will 
otherwise interfere and return irrelevant results where specific results are required).

To give you an example, we'll imagine we have the following tasks added to 2Do:

! Get a haircut one day

! Buy a new car some day

! Find a new job

! Call: Mother, tell about my new job

! Call: Tim

ANDing words:

Say you now wish to search for new AND job, you would type this into the search field: new 
job

This would return:

! Find a new job

! Call: Mum, tell about my new job

If you then wish to refine the search to return everything related to new job but not find, you 
would type: new job -find
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This would return:

! Call: Mum, tell about my new job

Similarly if you typed: a day this would return all tasks with 'a' and a 'day' in it:

! Get a haircut one day

! Buy a new car some day

ORing words:

To find tasks with words Call or New in them, you type just that: Call OR new (note: Capital 
OR). This would return:

! Buy a new car some day

! Find a new job

! Call: Mum, tell about my new job

! Call: Tim

Excluding words:

To exclude tasks with a specific word, simply prepend the word with an exclamation mark, 
e.g:

! !work

! !home

Matching Part of word:

To search for all tasks with the words newest, new, newer etc, you would type: new*
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Learn more about Soundex search
In a traditional search engine implementation, search is performed on the exact string you 
enter into the search field. So if you misspelled a word during task creation, tough luck 
finding it from hundreds of other tasks. 

Although we recommend exercising good typing skills, in a task management application it is 
quite common to make typos as you're racing against time during quick data entry. Names of 
places, people and products are commonly misspelled. This is where Soundex Search 
comes to the rescue. Instead of waiting for or worrying about the automatic spell checker 
during task creation, you spend less time typing and more time thinking about what you need 
to do next. When it's time to look for and search for that task you entered to 'Call the 
plumver', Soundex Search does whatever it needs to do to find that task even if you, at 
search time, spelled it correctly: "plumber". Search results are matched not against a 'string' 
but instead a 'sound'. So 'alexnder', 'alexander' and 'aleknder' would all sound alike. In short, 
you never have to worry about what you search for when using Soundex.

2Do runs Soundex, by default, against a task's title, notes, tags, dates and so on, thereby 
ensuring a task is found no matter what. After using search for a while you'd wonder what 
good a task manage app is without Soundex!

Using Quick Find to jump to a particular task
Although 2Do offers a powerful search feature, many times your intention isn't really to find a 
task while filtering out everything else. You simple want to 'jump' to a task which you vaguely 
remember by title. Quick Find lets you do just that.

Select ‘Task Find Bar' from Menu > View
Or simply hit the F key on your keyboard when focus is on the Task List to reveal the find 
bar.
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Type part of the title into Quick Find

�

This will result in searching your currently displayed list of tasks (or sub-tasks) and move the 
selection over to the first title that matches. This is useful as Quick Find will automatically 
expand the project / checklist for you in case the title matched a sub-task.

Understanding Smart lists
Smart Lists, in simpler words, are in fact saved searches. A smart list only filters on the 
original list it was create in (such as Home, 'All' and so on) and can be used for applying 
dynamic date range searches, keyword and tag filters.

You could, for example, create a Smart List to list all tasks that are only due tomorrow. The 
following are some examples of how you would create a certain type of Smart List.

Creating a 'Someday' Smart list

Creating a 'Tomorrow' Smart list

Creating a 'Next 3 Days' Smart list

Creating a 'Tasks with Tags' Smart list
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Creating a Smart List out of a fixed date range

Creating a 'Someday' Smart list
'Someday' is a popular list type for those of us who manage their tasks using the 'GTD' 
method. This list is where you would like all your undated but somewhat significant tasks to 
be listed. You could certainly simple create a 'Someday' list and create or move existing 
tasks in there; however there are times when you wish to keep tasks associated with their 
original lists or projects, and yet want to be able to periodically look at ones you would like to 
do some day.

Following is how you would leverage the Smart List functionality in 2Do to accomplish this 
(NOTE: You can also achieve a similar effect by using the Focus Filter; however, the 
following is a more permanent way of keeping a dedicated list assigned to undated tasks):

Click on the search options button

�

Click on Without Due Date

�

Click on [+] to create a Smart List

�
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Clicking on the [+] button left to the search field will create a Smart List from the currently-
applied search options.

This will result in listing all tasks that do not yet have a due date assigned.

Rename list to Someday

�

Creating a 'Tomorrow' Smart list
This is how you would create a Smart List that filters on all your lists to only display tasks 
due tomorrow.

Select the list you wish to search

�

A Smart List will only filter on the original list it was created in. Since our aim is to list all 
tasks from all lists that are due tomorrow, we will thus select the built-in All focus list.

Click the Search drop-down button

�
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Pick a Search Preset

�

1. Click on Search Presets

2. Click on [+] to add a new rule

3. Click on the default rule and select Due Date and then select ‘is’ and ‘Tomorrow’ for the 
sub-rules.

4. Click on Apply

Create a Smart List from search options

�

Click on the [+] button next to the search field to create a permanent Smart List from the 
currently-applied options.
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Rename new smart list to Tomorrow

�

Creating a 'Next 3 Days' Smart list
This is how you would create a Smart List that filters on all your lists to only display tasks 
due in the next three days. Note: By default 2Do creates a 'Next 3 Days' Smart List for you at 
install time.

Select the list you wish to search

�

A Smart List will only filter on the original list it was created in. Since our aim is to list all 
tasks from all lists that are due in the Next 3 Days, we will thus select the built-in All focus 
list.

Click on the search options button

�
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Click on Dynamic Range

�

! Enter '3' Days

! Click on ‘Apply'

! Rename list to ‘Next 3 Days’

Creating a 'Tasks with Tags' Smart list
This is how you would create a Smart List to show all tasks with any tag assignment.

Select the list you wish to search

�
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A Smart List will only filter on the original list it was created in. Since our aim is to list all 
tasks from all lists that are due tomorrow, we will thus select the built-in All focus list.

Click the Search button

�

Pick a Search Preset

�

1. Click on Search Presets

2. Click on [+] to add a new rule

3. Click on the default rule and change it to ‘Tag’ and then ‘is set’

4. Click Apply
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Creating a Smart List from a fixed date range
This is how you would create a Smart List that filters on all your lists to only display tasks 
due in a certain date range.

Select the list you wish to search

�

A Smart List will only filter on the original list it was created in. Since our aim is to list all 
tasks from all lists that are due in a range of dates, we will thus select the built-in All focus 
list.

Click on the search options button

�
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Click on Date Range

�

1. Select a 'From date'

2. Select a 'To date'

3. Click on Apply

This will result in filtering on all tasks with dates that fall between the two dates selected.

Click on [+] to create a new Smart List

�
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Advanced Search
2Do has an immensely powerful search engine that we have tried to expose via a myriad of 
options, buttons, checkboxes and dialogs as explored above. Yet, we have only scratched 
the surface. Much of this power can be tapped directly into by using one or more of a handful 
of built-in keywords that 2Do recognizes. Together, these keywords can be used to create 
complex and dynamic perspectives into your data, which would otherwise not be possible.

Without further ado, the following are five keywords you can use together or on their own.

1. type: 

This keyword is used to list the preset(s) to you would like to filter on. For example: “type: 
hiprio” will filter on all tasks with high priority. Supported presets are:

• alltasks: Any task (Project, Checklist, Subtask or Task)

• task: Tasks only

• subtasks: Subtasks only

• proj: Projects

• chck: Checklists

• sms: With message Action

• email: With email action

• browse: With URL Action

• visit: With visit Action

• google: With google Action

• action: With any Action

• audio: With audio attachments
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• pict: With picture attachments

• repeat: Recurring tasks

• prio: With priority

• noprio: Without priority

• hiprio: High priority

• medprio: Medium priority

• lowprio: Low priority

• overdue: Overdue

• inprogress: Task with a start date or duration, which is still in progress

• due: With due date

• tomorrow: Due or Start tomorrow

• duetomorrow: Due tomorrow

• today: Due or Start today

• duetoday: Due today

• donetoday: Completed today

• thisweek: Due or start this week

• duration: With duration

• starred: Starred

• alarms: With alarms

• nodue: Without due date
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• nostart: Without start date

• anytag: With a tag

• notag: Without a tag

• anylocation: With a location

• nolocation: Without a location

• note: With notes

Each one of these presets can be logically combined using OR, AND in addition to being 
grouped using brackets. Furthermore, you can inverse a preset by simply adding an 
exclamation mark to the front, e.g.: !alarms

Following are some examples:

type: (proj OR chck) AND hiprio AND !repeat

type: ((starred OR hiprio) AND due) OR today

2. tags:

Use this keyword to filter on tasks that use certain tags. You can create complex 
combinations by using brackets, AND as well as OR. When using a comma separated list, 
2Do implicitly translates a comma as an OR:

tags: home, work is equivalent to: tags: home OR work

tags: (home OR work) AND !play

tags: (call OR mail) AND work
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3. locations:

Use this keyword to filter on tasks that use certain locations. You can create complex 
combinations by using brackets, AND as well as OR. When using a comma separated list, 
2Do implicitly translates a comma as an OR:

locations: home, drycleaners is equivalent to: locations: home OR drycleaners

locations: (home OR work) AND !playground

4. groups:

This is a new addition to v2.1. This keyword can be used to filter on all tasks that belong to a 
certain list group. So, for example, if you had a list group called “PROJECTS” with five lists 
underneath, the following would lists only tasks that belong to this list group:

groups: projects

You can also filter on multiple list groups by using a comma separated list:

groups: home, work

Or even exclude a list group:

groups: !home

Combining Keywords
True power is felt when you’re able to in fact combine the above listed keywords together, 
forming truly powerful and complex smart lists. Although these keywords can be listed in any 
order you wish, if you are to combine these with a normal search keyword, the search 
keyword must appear before any built-in keyword, as shown below:

plumber type: starred tags: builders groups: home

Here, “plumber” is the search keyword while the rest of the built-in keywords have been used 
to narrow it down. 
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Currently, 2Do will implicitly insert a logical AND between the various built-in keyword 
combinations used, so you cannot at the moment do something like this: 

[NOT POSSIBLE] type: starred OR tags: home  
 
To do this, we advise you create two separate smart lists.

Here are some more examples showing how you can combine the built-in search words:

type: overdue tags: home OR school 

tags: someday type: anyprio OR starred groups: shopping

tags: !work type: (hiprio AND thisweek) OR starred groups: !work

Hiding completed tasks from Smart Lists
By default, a Smart List will list all tasks that matched the given search criteria without 
discrimination. Accordingly, it will also list tasks that have been marked as completed. This 
isn't always ideal as it adds unnecessarily visual clutter. For these situations, you can easily 
exclude completed tasks from your Smart List with a couple of clicks.

Right-click a Smart List

�

From the context menu, click on Exclude Completed Tasks.

To show completed tasks again, right click and this time click on 'Include Completed Tasks'.
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Calendar Control
Month at a glance
Spotting busy days

�

The calendar control at the bottom of the list panel offers various usability features. One of 
these is the ability to spot busy days. A small ribbon appears on top of the date if a task 
starts or is due on that day.

Repeating Tasks

In addition to that, it also shows a ribbon for future repeating tasks. So if a task 'Pay the 
electricity bill' was due on 5th of October and was set to repeat monthly, a marker would 
appear on top of the 5th of every subsequent month, even without ever marking the original 
task as completed. This is convenient as a single glance at the month calendar shows you 
what's coming next.
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Filter on dates
Click on dates to set a date range filter

�

In addition to showing you busy days and allowing you to drag and drop tasks on top of 
dates, the calendar also allows you to click on a single date, or click and drag over multiple 
dates, to set a date filter directly from the calendar (note: you can do this using Search 
Options as well). Clicking again on a selected date removes the search.

In the above screenshot, we're filtering on all tasks that are due between the 5th and the 
19th of October 2012.
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Alarms & Notifications
A task manager would be incomplete without alarms and notifications, and for this reason 
2Do comes bundled with support for the Mountain Lion Notification Center as well as a built-
in alerting system that works on OS X 10.7 (Lion) and later. A single task can be assigned 
multiple alarms, when get re-scheduled automatically for repeating tasks.

2Do gives you choice between the two. No matter which notification system you choose, you 
will be notified with an alert dialog whether 2Do is running or not running in the background. 
The following sections discuss each of the available notification methods.

Notification Center
Please note, Notification Center is only available as an option on Mountain Lion (OS 10.8) 
and later. 

Advantages
! Alerts appear in Notification Center along with alerts from other application 

Caveats
! The ‘Nag’ feature is not supported (see the next section below) 

! Snooze (coming soon) will not be supported

! Multiple alerts from the same application don’t appear next to each other when displayed 
for the first time on your desktop

2Do 
Compatible with Lion (OS 10.7) as well as Mountain Lion.

Advantages
! A custom sounds alert along with a subtle bell animation is shown for each alert, 

intended to grasp immediate attention

! Alert sound can be set to repeat (nag) on an interval. 

! Multiple alerts from multiple tasks can appear on the screen, all at once
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! Alerts go off even when application is not running / was not launched

! Snooze will be supported soon

Caveats
! None
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Synchronization
The different sync options
2Do supports synchronization between multiple Macs, iOS and Android devices running a 
copy of the app. With synchronization set up, your lists and tasks will appear on all devices 
without extra effort on your part.

2Do supports a number of popular cloud solutions: iCloud, Dropbox, Toodledo and 
CalDAV (custom iCal servers). There are, however, a set of caveats with each of these sync 
methods. The main problem stems from the fact that 2Do supports far more properties for a 
task than any of these cloud solutions. Things like Tags, Recurring options, Alerts, 
Embedded sounds and pictures are extra information you can assign to your tasks in 
2Do,but these don't translate well to the supported sync methods. You can find out more 
about each sync method and its associated caveats in the following chapters:

Sync using iCloud

Sync using Dropbox

Sync using Toodledo

Sync using CalDAV

Sync using iCloud
Advantages
! Your lists and tasks from the Reminders app (on iOS or Mac) will automatically sync with 

2Do

! You will be able to create tasks using Siri on iOS (iPhone / iPad / iPod)

! You can access your synced tasks online using a browser (www.icloud.com)

! Syncing is Fast, and 2Do will automatically be able to perform sync in the background or 
at various intervals

! Your lists and tasks will sync with any other client connected to your iCloud CalDAV 
account 
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! Pictures and audio notes from 2Do will sync across to other devices running 2Do

! Multiple alarms on a single task in 2Do will sync across to Reminders as-is

Caveats
! Smart lists from 2Do will not sync to the Reminders app (on iOS / Mac)

! Projects and checklists from 2Do will appear as simple tasks in Reminders but will, 
however, sync as projects and checklists to other devices running 2Do

! Tags from 2Do will not appear in the Reminders app

! Only tags assigned to a task in 2Do will sync across to other devices running 2Do. 
Unused tags will not sync.

Setting up iCloud Sync

�

1. From the menu 2Do > Preferences... click on Sync
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2. Enter your iCloud account details. Login and sync will be performed using a SSL 
connection.
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Sync using Dropbox
Advantages
! All your tasks with their attachments and alarms, the lists, tags (used and unused) as 

well as smart lists from 2Do will sync across to other devices running 2Do

! 2Do will automatically be able to perform sync in the background, or at various intervals

! Extremely reliable and robust. Sync method of choice.

Caveats
! Unlike iCloud and Toodledo, Dropbox does not have a web-interface for managing tasks. 

This really isn't an issue if you only ever use your devices to manage and sync your 
tasks. 
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Setting up Dropbox Sync

�
1. From the menu 2Do > Preferences... click on Sync

2. Select Dropbox from the Account Type drop-down

3. Click on Link to Account

If you do not already have a Dropbox account, you can create a free one by clicking on 
Signup.
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Authorize 2Do

�
Clicking on the link button will open an authentication page in a browser. Enter your dropbox 
account details there and click on Allow.

That will take you back to 2Do where you should now see a new section of 'Managed Linked 
Devices'. If you've got more devices running 2Do and synchronizing using Dropbox, you can 
manage them from there.
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Sync using Toodledo
Advantages
! You can access your synced tasks online using a browser (www.toodledo.com)

! If you have a Toodledo Pro / Plus account, your projects and checklists from 2Do will 
sync as projects and checklists to Toodledo

! Use email to create tasks and sync with 2Do. Toodledo gives you a unique email-
address to which you can email tasks. This allows you to add tasks to Toodledo (and 
thus to 2Do) from any email client. You can even use Siri to compose these emails for 
you. 

! Tags will sync from 2Do to Toodledo

! Repeating tasks will sync to Toodledo

Caveats
! Automatic background sync is not available as an option. You will have to click on the 

Sync button each time you wish to sync. This is because Toodledo puts a limit on the 
number of times a device can sync (along with the number of tasks that it can sync at 
one time) and will suspend the account if it's syncing too often. If automatic background 
sync is important to you, please explore the other sync options such as Dropbox or 
iCloud.

! Smart lists from 2Do will not sync to Toodledo

! Projects and checklists from 2Do will appear as simple tasks in Toodledo if you don't 
have a Toodledo Pro / Plus account but will, however, sync as projects and checklists to 
other devices running 2Do

! Only tags assigned to a task in 2Do will sync across to Toodledo. Unused tags will not 
sync.

! Audio and picture attachments in 2Do will not sync to Toodledo or to other devices 
running 2Do

! Alarms from 2Do will not sync to Toodledo

! Emoji UTF-8 characters cannot be used in task titles or notes as Toodledo does not 
support them. In fact, ToodleDo will replace Emoji characters with question marks, and 
all tasks that had an Emoji will be duplicated: one will have the Emoji, the other will not.
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Setting up Toodledo Sync

�
1. From the menu 2Do > Preferences... click on Sync

2. Select Toodledo from the Account Type drop-down

3. Enter account details and click Connect

If you don't already have a Toodledo account, you can create a free account by clicking on 
Signup.

Sync using CalDAV
Advantages
! Immense flexibility. Use your own custom CalDAV Server hosted anywhere or by 

anyone.

! You will be able to create tasks using other clients connected to the CalDAV server

! You can access your synced tasks online using browser and a web-based CalDAV client
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! Syncing is Fast, and 2Do will automatically be able to perform sync in the background or 
at various intervals

! Pictures and audio notes from 2Do will sync across to other devices running 2Do

! Multiple alarms on a single task in 2Do will sync across to the CalDAV server as-is

Caveats
! Smart lists from 2Do will not sync to the CalDAV server

! Projects and checklists from 2Do will appear as simple tasks in CalDAV but will, 
however, sync as projects and checklists to other devices running 2Do

! Repeating tasks will sync as normal tasks with CalDAV but will, however, sync normally 
to other devices running 2Do

! Tags from 2Do will not sync to CalDAV

! Only tags assigned to a task in 2Do will sync across to other devices running 2Do. 
Unused tags will not sync.
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Setting up CalDAV Sync

�
1. From the menu 2Do > Preferences... click on Sync

2. Enter your CalDAV username and password

3. Enter the server address, port number and check SSL if the server will be connected 
via a SSL connection.

4. Click Connect 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Replace Server data or Local Data? 
The first time you sync 2Do on a device by whichever sync  method you have chosen, you 
will be asked to specify if you wish to "Replace Server Data” or "Replace 2Do Data.” In this 
context, "Server” refers to the service on the other side of the sync process (iCloud, 
Dropbox, ToodleDo, or a CalDAV server); and "Local” refers to the app installed on your 
device. For some sync methods the default is set to “Merge”, which essentially means that 
during your first sync, data from 2Do (your local machine) will be merged with data present 
on the server (the other side). This way you don’t lose tasks on either side but can at the 
same time create duplicates in case you had the same tasks locally or on the server.

If you have tasks in 2Do and have never performed a sync, then the server-side is empty, 
and you MUST choose "Replace Server Data” for your first sync.  This will push a copy of 
your 2Do database from your device up to your chosen sync service; what was empty on the 
server will now contain all the tasks from your mobile device. If you make a mistake and 
choose "Replace 2Do Data”, what’s on the server (nothing) will be pushed down to your 
device, and your tasks will be wiped from the app. If that happens, you can recover and start 
again – please read the topic entitled Backups.

If you do not have tasks in 2Do, and you have tasks on the server-side (because you’ve 
been using the toodledo.com website, or because you’ve already been syncing another 
mobile device and you now want those tasks to appear on another mobile device), you 
MUST choose "Replace Local Data” for your first sync. This will pull a copy of your 2Do 
database from the server down to 2Do on your device.  If you make a mistake and choose 
"Replace Server Data”, what’s on your device (nothing) will overwrite what’s on the server 
(everything), and this is potentially NOT recoverable.  Please take great care in this situation.

Once you have a successful sync, the app should reset to "Sync Normally”, but you might 
wish to double-check. In a normal sync, changes are pushed in both directions: from the app 
up to the server, and from the server down to the app. This allows you to make changes to 
your tasks on two or more devices,  and to have those changes reflected on your other 
devices.

One thing to note here is that under normal circumstances the ‘Server’ always contains the 
most up-to date data (unless you delete data from the server directly otherwise). Thus, it’s 
always safe to “Replace local data” in case you wish to replace all data present locally on 
your Mac / mobile device. You may wish to do this, for example, in case one of your devices 
is terribly out of sync (hasn’t been synced for weeks) and you’d rather get a fresh copy 
directly from the server.
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Preventing selected lists from being Synchronized
Open menu 2Do > Preferences... > Sync

�
! Select Exclusions from under Sync preferences

! Check the lists you would like to exclude during Sync

These lists will then be skipped the next time they're synced. If these lists were synced in the 
past, they will get deleted on other devices syncing to the same account.
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Backups
Managing manual and automatic backups
We know how important the role of a task management app is: you typically plan your whole 
life through it.Accordingly, it would be disastrous to lose your data for whatever reason, 
especially if you accidentally deleted something and weren't otherwise relying on system 
backups.

2Do automatically takes a snapshot of your database every 24 hours (configurable in backup 
preferences). You can restore from an existing backup, transfer a backup to another 
machine, or create backups manually at will. A backup is also automatically created for you 
before performing synchronization. So in case something went terribly wrong somewhere 
else on another device (in case you're synchronizing multiple Macs / mobile devices), rest 
assured you will easily be able to recover your old data with little or no effort.

�79



Creating a manual backup

�
! Open Preferences (2Do Menu > Preferences...) and select Backups

! Click on the [+] button to create a new backup

! Select the newly created backup from the list and click 'Save as...' in case you wish to 
keep an external copy of the newly created backup
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Restoring a backup
Restoring an automatic backup
! Open Preferences (2Do Menu > Preferences...) and select Backups

! Select the automatic backup you wish to restore from the Manage Backups list

! Click Restore...

! Follow prompts

Restoring from an external file

�
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2Do allows transferring its backed-up database across to other machines running a copy of 
2Do for restore. This also includes iOS devices. If you wish to restore 2Do from an existing 
backup file, follow the instructions given below.

! Open Preferences (2Do Menu > Preferences...) and select Backups

! While holding down the Option (alt) key on your keyboard, click on the 'Restore...' 
button

Point the Open Dialog to the file on disk and follow screen prompts
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